
Experiment EP-1: Cardiac Recovery after Exercise

Background

During exercise, there is an increased demand for oxygen in muscles and an increased need to move 
carbon dioxide away from those muscles. People with higher levels of physical fitness usually have 
higher stroke volumes and can deliver more oxygen in a single cardiac cycle than people with lower 
levels of fitness. More fit persons can usually sustain a greater work level before reaching maximum 
heart rate. Less fit subjects of the same age and gender will reach about the same maximum heart rate, 
in a shorter period of time; and, they are usually unable to sustain the same level of work. However, the
time from resting to maximum heart rate is not a good indicator of fitness; this time is a reflection of 
the effort put into exercise by the subject.

As soon as exercise stops and the demand for oxygen and the transport of carbon dioxide decreases, 
heart rate decreases. The heart rate of a more fit person usually returns to the resting rate more quickly 
than it does in a less fit subject. Recovery rate, which is the drop in heart rate between the end of 
exercise and the 1-minute mark of the recovery period, is an excellent measure of fitness. Studies have 
shown that a drop of 50 beats in the first minute indicates excellent fitness, and a drop of less than 30 
beats in the first minute indicates poor fitness. The time to recover to the resting level is also a good 
indicator of fitness, though less used than recovery rate. More fit subjects take shorter times to reach 
complete recovery.

Cardiorespiratory fitness levels can be determined through many types of aerobic assessment: the 2-
minute, positional step test; the 3-minute step test; the 1-mile walk test; and more. In this experiment, 
the heart rates of human subjects will be measured as they recover from a three minute period of 
stepping. The heart rate at a minute into recovery, and the time it takes the subject’s heart rate to return 
to the resting level, will be used as measures of the subject’s level of the physical fitness.

Equipment Required

PC or Macintosh computer

IX-ELVIS

USB cable

Power supply

PTN-104 Pulse plethysmograph

Step (30cm (12in) in height)

Metronome (electronic or mechanical)

Stopwatch

IX-ELVIS Setup

1. Place the IX-ELVIS unit on the bench, close to the computer. 

2. Connect the IX-ELVIS to the computer with the supplied USB cable. 

3. Insert the power plug into the rear of the IX-ELVIS and plug the transformer into the electrical 
outlet. Turn on the power switches on the rear and on the upper right side of the top of the unit 
and confirm that the LEDs are illuminated.
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Start the Software

1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is 
not available, click on the Windows Start menu, move the cursor to All Programs and then to 
the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window 
will appear as the program opens.

2. On the Main window, pull down the Settings menu and select Load Group.

3. Locate the folder that contains the settings group, ELVISNI.iwxgrp. Select this group and click 
Open.

4. Pull down the Settings menu again. Select the CardiacRecovery-Exercise-LS2 settings file.

5. After a short time, LabScribe will appear on the computer screen as configured by the 
CardiacRecovery-Exercise-LS2 settings.

6. The settings used to configure the LabScribe software and the IX-ELVIS for this experiment are
programmed on the Preferences Dialog window which can be viewed by selecting Preferences 
from the Edit menu on the LabScribe Main window.

Pulse Sensor Setup

1. Locate the PTN-104 pulse plethysmograph (Figure EP-1-S1).

2. Plug the mini-DIN connector to the PT-104 into the Channel 3 input of the IX-ELVIS (Figure 
EP-1-S2).

Figure EP-1-S1: The PTN-104 pulse plethysmograph.
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Figure EP-1-S2: The PTN-104 pulse plethysmograph connected to an IX-ELVIS.

3. Place the plethysmograph on the volar surface (where the fingerprints are located) of the distal 
segment of the subject’s middle finger or thumb, and wrap the Velcro strap around the end of 
the finger to attach the unit firmly in place.

Preparation before Exercise Begins

1. Each subject will perform a three minute period of stepping. There will be a 5-minute rest 
period before the three minute exercise period, and a recovery period after stepping that will be 
as long as it takes the subject’s heart rate to return to the resting value. Lab partners should keep
time for the rest, exercise, and recovery periods.

Warning: The Step Test should not be attempted by individuals with a very poor level of 
physical fitness, or individuals taking a beta blocker medication or any medication affecting 
heart rate.

2. The step rate will be 24 steps per minute. 

3. Each step is a four-beat cadence, so the metronome will be set to 96 beats per minute.

4. The movements for each of the four beats in a step are:

• 1st beat: Right foot up on step.

• 2nd beat: Use the right leg to lift body, and place left foot on step

• 3rd beat: Lower the right foot to the ground.
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• 4th beat: Lower the left foot to the ground.

5. It is important to secure the step against the side of a lab bench or up against a wall to prevent it 
from slipping from under the feet of the subject.

Exercise 1: Heart Rate at Rest

Aim: To measure the heart rate of a resting subject.

Procedure

1. Instruct the subject to sit quietly and rest with his or her hands in the lap for five minutes.

2. Type “<Subject’s Name> Sitting at Rest” in the Mark box that is to the right of the Mark button.

3. At the end of the five minute rest period, click on the Record button, located on the upper right 
side of the LabScribe Main window. The signal should begin scrolling across the screen.

Note: If the user clicks the Record button and there is no communication between the IX-
ELVIS and computer, an error window will appear in the center of the Main window. Make 
sure the IX-ELVIS is turned on and connected to the USB port of the computer. Click OK 
and select the Find Hardware function from the LabScribe Tools menu. 

4. Click on the AutoScale buttons at the upper margins of the Pulse and Heart Rate channels. The 
pulse signals and heart rate histogram should expand to fill the channel windows (Figure EP-1-
L1). 

• If the signal on the Pulse channel is upside down when compared to trace in figure, click on 
the downward arrow to the left of the channel title and select the Invert function. the trace 
should now look similar to the one in the figure.

• If the pulse signal is small or noisy, adjust the tension on the strap holding the pulse 
plethysmograph to the finger.

5. Record the subject’s resting heart rate for one minute. Then, click Stop to halt the recording.

6. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 
in which to save the file. Designate the file type as *.iwxdata. Click on the Save button to save 
the data file.

7. Remove the pulse plethysmograph from the subject’s finger.
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Figure EP-1-L1: Pulse and heart rate from a resting subject displayed in the Main window.

Data Analysis

1. Scroll to the beginning of the recording of the subject’s heart rate while at rest. Display a ten 
second section of data that is free of artifacts in the Main window.

2. Use the Display Time icons to adjust the Display Time of the Main window to show ten seconds
of data on the Main window. The ten second section of data can also be selected by:

• Placing the cursors on either side of the ten seconds of data; and

• Clicking the Zoom between Cursors button on the LabScribe toolbar (Figure EP-1-L2) to 
expand the ten seconds of data to the width of the Main window.

Figure EP-1-L2: The LabScribe toolbar.

3. Click on the Analysis window icon in the toolbar (Figure EP-1-L2) or select Analysis from the 
Windows menu to transfer the data displayed in the Main window to the Analysis window 
(Figure EP-1-L3).

4. Look at the Function Table that is above the uppermost channel displayed in the Analysis 
window. The mathematical function, Mean, should appear in this table. The value for the mean 
heart rate should appear across the top margin of the Heart Rate channel.

Exercise Physiology-CardiacRecovery-Exercise EP-1-5

file:///Users/stephenhauptman/Desktop/iWorx/IFHPLMv2/CardiacRecovery-Exercise-F-LS2.htm#Rak35627
file:///Users/stephenhauptman/Desktop/iWorx/IFHPLMv2/CardiacRecovery-Exercise-F-LS2.htm#Rak55723
file:///Users/stephenhauptman/Desktop/iWorx/IFHPLMv2/CardiacRecovery-Exercise-F-LS2.htm#Rak55723


5. Place a cursor near the beginning of the data displayed on the Analysis window, and place the 
other cursor near the end of the data displayed on the window. The cursors are in the correct 
positions for determining the mean resting heart rate of the subject from the ten seconds of data 
on the window.

6. Record the mean resting heart rate of the subject in the on-line notebook of LabScribe by typing
the name and value of the parameter directly into the Journal. You can open and close the 
Journal by clicking on its icon on the LabScribe toolbar (Figure EP-1-L2).

Figure EP-1-L3: Pulse and heart rate from a resting subject displayed in the Analysis window.

7. The functions in the channel pull-down menus of the Analysis window can also be used to enter
the names and values of parameters from the recording to the Journal. To use these functions:

• Transfer the names of the mathematical functions used to determine the volumes and rates 
to the Journal using the Add Title to Journal function in the Heart Rate Channel pull-down 
menu.

• Transfer the values for the volumes and rates to the Journal using the Add All Data to 
Journal function in the Heart Rate Channel pull-down menu.

8. Record the mean resting heart rate for in Table EP-1-L4.

Exercise 2: Heart Rate During Recovery

Aim: To measure the changes in the heart rate of the subject while he or she recovers from exercise.

Procedure

1. After the subject’s resting heart rate is recorded, the subject should stand in front of the step and
await the signal of the timekeeper.

2. Once the timekeeper calls “Start!”, the subject should begin stepping at the rate of 24 
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steps/minute for 3 minutes.

3. While the subjects are stepping, the lab partners can enter pertinent data into the Journal. 

4. Thirty seconds before the end of the stepping exercise, the timekeeper should alert the subject 
and other lab partners to be ready attach the pulse plethysmograph. Type “Recovery from 
Exercise” in the Mark box that is to the right of the Mark button.

5. The timekeeper should give the subjects and the lab partners a 10 second countdown before 
calling “Stop!”. At the end of the 3-minute stepping exercise, each subject should immediately 
sit in a chair and attach the pulse plethysmograph to the same finger with about the same 
tension used earlier.

6. As soon as the subject is seated and the pulse plethysmograph is in place, click on the Record 
button. Click on the AutoScale buttons on both channels.

7. Continue to record the subject’s pulse until his or her heart rate returns to the resting level. Click
on the Stop button.

8. Select Save in the File menu.

Data Analysis

1. Scroll to the beginning of the recording of the subject’s heart rate during the recovery period. 
Display a ten second section of data that is free of artifacts in the Main window.

2. Use the Display Time icons to adjust the Display Time of the Main window to show ten seconds
of data on the Main window. The ten second section of data can also be selected by:

• Placing the cursors on either side of the ten seconds of data; and

• Clicking the Zoom between Cursors button on the LabScribe toolbar (Figure EP-1-L2) to 
expand the ten seconds of data to the width of the Main window.

3. Click on the Analysis window icon in the toolbar (Figure EP-1-L2) or select Analysis from the 
Windows menu to transfer the data displayed in the Main window to the Analysis window.

4. Position a cursor on either side of the five pulses on the Pulse channel. The value for Mean in 
the table across the upper margin of the Heart Rate channel is the subject’s mean heart rate at 
the start of the recovery period.

5. Record this value in the Journal using one of the two techniques described in Exercise 1. Enter 
the value for this mean heart rate in Table EP-1-L3.

6. Use the same techniques described earlier to measure the mean heart rate at one minute 
intervals from the beginning of the recovery period. Record these values in the Journal and on 
Table EP-1-L3.

Fitness Ratings

1. For each subject, use the measurements made in the Data Analysis section to fill in Table EP-1-
L3.

2. From the data in Table EP-1-L3, determine:

• The difference between the subject’s resting and maximum heart rates.

• The difference between the subject’s maximum and one-minute recovery heart rates.
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• The time for the subject to recover from maximum heart rate to a heart rate equal to the 
resting rate.

3. Compare the subject’s one minute recovery heart rate to the first table of fitness ratings (Table 
EP-1-L1).

4. Compare the subject’s time to recover to his or her resting heart rate to the ratings in a second 
fitness table (Table EP-1-L2).

5. Enter measurements and ratings into the Journal by typing them directly into the Journal 
window.

Table EP-1-L1: Fitness Rating based on Heart Rate at 1-Minute into Recovery after a 3-Minute 
Aerobic Step Test.

Fitness Rating Gender Heart Rate (BPM)

Excellent
Male <71

Female <97

Good
Male 71-102

Female 97-127

Fair
Male 103-117

Female 128-142

Poor
Male 118-147

Female 143-171

Very Poor
Male 148+

Female 172+

Table EP-1-L2: Fitness Rating based on the Time to Recover to Resting Heart Rate.

Time to Recover to 
Resting Heart Rate

Rating

0-30 secs Excellent

31-60 secs Good

61-90 secs Fair

91-120 secs Poor

121+ secs Very Poor
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Questions

1. How does the difference between the resting and maximum heart rate of a subject relate to his 
or her fitness?

2. How do the resting and maximum heart rates of all the subjects compare? Do the subjects’ 
levels of fitness correlate to the resting heart rates, the maximum heart rates, and/or the 
differences between the two heart rates?

3. How does the difference between the maximum and recovery heart rate of a subject relate to his
or her fitness?

4. How do the maximum and recovery heart rates of all the subjects compare? Do the subjects’ 
levels of fitness correlate to the maximum heart rates, the recovery heart rates, and/or the 
differences between the two heart rates?

5. How does the time taken to recover to resting heart rate relate to the fitness of each subject? 
How do the times to recovery for all the subjects compare?

6. How do the two techniques of determining fitness (one minute recovery and time to recovery) 
compare to each other? Are they consistent?

7. Do you agree with the fitness ratings obtained from this experiment? Explain.

8. Examine the data of a fit subject. Predict what his or her maximum heart rate might be, if he or 
she exercised for five minutes instead of three minutes.

9. Examine the data from a less fit subject. Predict what his or her maximum heart rate might be, if
he or she exercised for five minutes instead of three minutes.

Table EP-1-L3: Heart Rates at 1-Minute Intervals into Recovery

Rest Max

Time (mins) 0 1 2 3 4 5 6 7 8 9 10

HR

(BPM)
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